
Teacher Guide

Lessons for Middle & High School Students: Grades 6 - 9 

Technology Course 
using 

Google Apps
Launch a business venture. 
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Introduction 

Introduction

This section provides valuable information about teaching 

TechnoRestaurateur. It includes an overview of the course. In addition, there 

are ideas for implementation and technology integration. 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

TechnoRestaurateur Overview 

TechnoRestaurateur Course Outline 

Technology Integration Ideas 
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TechnoRestaurateur Overview 

 

In this course, students become restaurateurs. The fun begins as the 

fledgling entrepreneurs survey their classmates to learn about the type 

of cuisine to serve their patrons. The survey data is arranged in a 

spreadsheet and transformed into a graph. This information is then used 

to explain the new business venture to potential investors in a well-

written letter. Having generated enough money to start up their 

restaurant, students draft a floor plan. The restaurant is really starting to 

take shape! 

 

Soon the restaurateurs’ dreams become a reality – the restaurant is opened to the public and it 

is a huge success. Earnings are calculated using spreadsheet formulas. The business is making 

enough money to expand its operation. Students create a newsletter to promote their restaurant 

concept as an excellent business opportunity. 

 

Students complete the following tasks: 

 

➢ In Session 1, students become restaurateurs. They will launch an imaginary 

restaurant venture. To start, they explore Google Sheets to learn basic 

spreadsheets skills including terminology, data entry, and simple cell formatting. 

➢ In Session 2, students formulate a plan for their business venture. To start they 

survey their classmates to determine the type of cuisine to serve at their 

restaurant. With this data, students tabulate and chart the results using Google 

Sheets. By interpreting the survey results, students select the type of restaurant 

they would like to own and operate. They form a business plan that outlines the 

cuisine, company name, main menu items, and the target customer. 

➢ In Session 3, students generate start-up funds from investors for their business 

venture. To start, they design a company logo using drawing tools in Google 

Slides. This is exported as a picture file. If your students require an extra challenge, 

teach the optional extension activity first, as it contains advanced graphics 

techniques that can be used to produce a unique design. Afterwards, students 

use Google Docs to create a letterhead that includes the company logo. They 

use the document to write a professional letter explaining their business concept. 

It will include the graph from the survey to demonstrate their rationale for 

targeting a particular cuisine. Investors are sure to want to fund such an exciting 

venture! 

➢ In Session 4, students apply the drawing tools of Google Slides to design the floor 

plan of their restaurant. Students consider their clientele and the type of dining 

experience they are expecting. Shortcuts to complete the project are introduced 

as students design seating arrangements that can be easily grouped and 

duplicated to place elsewhere in the layout. Students create a well-designed 

restaurant with a focus on functionality. If time permits, an optional extension 

activity applies Slides to create an electronic bulletin board that displays special 

offers or upcoming events to customers. 

➢ In Session 5, students learn advanced spreadsheet skills by designing a worksheet 

to calculate their monthly, quarterly, and yearly earnings. Using Google Sheets 

students use the Fill Series option to easily create a table that holds financial 

information. Calculations such as Sum and Average give students a clear 

overview of their earnings. This information is then displayed in chart format with a 

trendline that predicts future growth. 



Getting Started 

Copyright © TechnoKids Inc. iii TechnoRestaurateur | Google Workspace 

➢ In Session 6, students create a newsletter for aspiring restaurateurs interested in

joining a restaurant chain. The publication's aim is to persuade them to become

part of the team and open their own restaurant. It will include the same

company logo, offer identical menu items, and showcase a similar floor plan.

Additionally, the newsletter will highlight potential earnings and outline the

benefits of participating in the business venture. Can you convince others to join

the team?
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TechnoRestaurateur Course Outline 
  

Purpose: Develop spreadsheet, word 

processing, and graphic skills. Use Google 

Workspace to launch a successful restaurant 

venture. 

Preparation: 

• Install Google Chrome 

• Sign up for a Google account 

• Share Restaurateur folder with students 

• Download and print Flashcards and Tool 

Summary from TechnoHub (optional) 

 

Objectives: (see Appendix A: Skill Summary) 

• problem solve to make logical decisions 

• collect data using a survey 

• organize and sum survey data 

• graph data and interpret results 

• develop a plan based on the evidence 

• create a company logo  

• write a persuasive professional letter 

• draft a well-organized floor plan 

• analyze financial earnings using formulas 

• apply a linear trend line to a graph 

• design a newsletter to promote concept 

Materials: 

• Assessment: Letter Checklist, Letter Marking 

Sheet, Newsletter Checklist, Newsletter Marking 

Sheet, Restaurateur Skill Summary 

• Google Samples: Restaurateur Workbook, Logo, 

Letter, Floor Plan, Newsletter, Advertisement 

• Parent Letter and Certificate 

• Flashcards and Tool Summary (optional) 

• Restaurateur folder: 

o Autoshapes folder 

o Conduct a Survey worksheet 

o PDF Samples: Restaurateur workbook, Logo, 

Letter, Floor Plan, Newsletter 

o Advertisement shortcut (Extension Activity 4) 
  

Summary of Activities: 

• Consider how Google Workspace can help launch a restaurant venture. 

• Explore Google Sheets to understand spreadsheet terminology and acquire basic skills. 

• Conduct a survey to investigate cuisine preferences. 

• Organize survey results using Google Sheets. Format the data to make it easy to read. 

• Graph survey results using a pie chart. Format the graph. 

• Interpret the survey results to develop a business concept based on evidence. 

• Create a company logo using Google Drawings. 

• Write a professional letter requesting seed money for the restaurant from investors in Google Docs. 

• Draft a floor plan for the restaurant that meets the needs of staff and patrons in Google Drawings. 

• Organize monthly profits using Google Sheets. Analyze earnings to develop a business strategy. 

• Calculate quarterly and average earnings to determine the financial health of business. 

• Graph quarterly earnings using a line graph and apply a trend line to predict future profits. 

• Design a newsletter to promote the restaurant concept as a business opportunity. 

Extension Activities: 

• Review a Business Proposal: Insert a Review Tracker to request feedback on the business proposal. 

• Advertise a Deal: Inform customers using an animated bulletin board. 

• Analyze Earning With Functions: Use SUM, AVERAGE, MIN, MAX, and COUNT functions. 

• Share Files with Investors: Insert a link to the worksheet and floor plan into newsletter. Share file. 

• Rate Opinions in Forms: Measure customer satisfaction with a rating scale grid. 
 

Assessment: 

• Self-Evaluation (Letter Checklist and Newsletter Checklist) 

• Teacher Evaluation (Letter Marking Sheet, Newsletter Marking Sheet, Skill Summary) 

 

Notes: 

• This course focuses on developing spreadsheet, word processing, and graphic skills in an interesting 

way. Extend learning to include presentation and data management skills by completing the 

extension activities. 

• Review the concept of percent prior to teaching Assignment 5, and average prior to teaching 

Assignment 11. 

https://technohub.technokids.com/
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Technology Integration Ideas 

TechnoRestaurateur integrates into curriculum. This course uses Google Workspace to launch a 

successful restaurant venture. Students apply critical and creative thinking to develop a unique 

business concept. The activities integrate technology into language arts, mathematics, and 

visual arts. There are several ways to include TechnoRestaurateur as part of a unit of study: 

• Mathematics Problem Solving Unit

Have your students learn through problem solving. The activities in TechnoRestaurateur

connect mathematics to a real-world situation. Students are challenged to conduct

market research, analyze the findings, and develop a business concept based on the

evidence.

• Mathematics Graphing Unit

Teach graphing techniques in a meaningful way. TechnoRestaurateur includes activities

for displaying survey data in a pie chart, and financial earnings in a line chart. By

interpreting the charts students determine a viable business strategy and measure the

financial health of their restaurant.

• Entrepreneurship Unit

Incorporate TechnoRestaurateur as part of a business studies, finance, or

entrepreneurship course. The scenario allows students to engage in tasks that many

business owners must complete such as creating a logo, requesting seed money,

designing a floor plan, analyzing financial earnings, and promoting the concept.

• Computer Course

TechnoRestaurateur can be included as part of a computer course or class.

TechnoRestaurateur offers a unique way to introduce students to Google Workspace.

Students learn spreadsheet, word processing, and graphic skills. The extension activities

include presentation and data management skills.

• Integrated Technology Unit

Develop technology, mathematics, language, and visual arts skills. Use Google Sheets to

analyze data, Google Docs to persuade others to invest, Google Drawings to create a

logo and floor plan, Google Slides to design an advertisement, and Google Forms to

measure customer satisfaction.

Understand the Big Picture 

Not sure where to integrate TechnoRestaurateur? View samples to gain a better understanding 

of the course. The Restaurateur sample is a summary of survey results and financial earnings. The 

Logo and two Floor Plan samples illustrate the artwork students create. The Letter and Newsletter 

samples show the two persuasive writing tasks. Advertisement is a sample of the optional 

challenge in Extension Activity 4. 



 

 

 

Session 1 Become a Restaurateur 

 

Session 1 

Become a Restaurateur 

In this session, students become restaurateurs. They will launch an imaginary 

restaurant venture. To start, they explore Google Sheets to learn basic 

spreadsheets skills including terminology, data entry, and simple cell 

formatting. 

Assignment 1: Become a Restaurateur 

Assignment 2: Learn Basic Spreadsheet Skills 
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Assignment 1: Become a Restaurateur 

You are going to become a restaurateur.  

A restaurateur is a person that opens and runs a restaurant. 

The restaurant you operate can be imaginary or you can make a plan to sell 

food at a school or community event. 

You will use Google Workspace to support this exciting business venture. 

Learn more about how Google Workspace can help you. 

What Are the Job Duties of a Restaurateur? 

A restaurateur is responsible for opening a restaurant and then running the business.  

It is a job that requires a variety of skills. Check ✓ the job duties you would enjoy doing. 

✓

Talk to others about ideas for a new restaurant. 

Get people to invest money in a new restaurant. 

Design a company logo. 

Create a restaurant floor plan. 

Keep financial records. 

Advertise the restaurant. 

Make sure customers are happy. 

How Can Google Workspace Help You? 

1. You will use the spreadsheet program Google Sheets to organize, calculate, and graph

data. This will help you to make decisions, such as what type of food to serve. It will also

allow you to track information, so you will know if you are making money.

a. Have you used a spreadsheet program before?  yes  no

b. If yes, what program did you use?

2. You will use the word processing program Google Docs to create professional documents.

This will help you share information with others.

a. You will write a letter to convince others to invest in your new restaurant.

Who could you ask to lend you money?

b. You will make a newsletter to advertise the restaurant idea to other people who are

interested in starting their own business. Who do you know that would make a good

restaurant owner? Why would they be good at this job?
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3. You will use Google Drawings to create artwork. You will make a logo to represent your 

restaurant. You will also design a floor plan to organize your ideas.  
   

 a. A company logo is a picture used to represent a business. It can be put onto signs, 

business cards, shirts, pens, and any other surface. 

 

Look around the room to find three logos you like. Record your findings: 
   

  Company Name Location of the Logo 

    

    

    

 

 

 b. A floor plan is a drawing that uses symbols and lines to show the location of items. 

List furniture or other items that your restaurant will need. 
    

  • table • stove, fridge • toilets 

  • chairs • sinks • plants 

 

 

4. You can use the presentation program Google Slides to design an electronic bulletin 

board of menu items. This will allow you to advertise special offers to customers.  

   

 a. What offers, deals, or promotions are offered by other restaurants that you like? 
    

  • Two items for the price of one. Free dessert on your birthday. 

  • Save 50% off any menu item on Wednesdays. 

    

   

 b. Making an advertisement using Google Slides is an optional activity.  
   

  Would you like to do this activity?  yes  no 

 

 

5. You can use the data management program Google Forms to collect information about 

customer satisfaction. This will help you to improve your business. 
   

 a. Happy customers are likely to return to the restaurant.  

List two things that are important to you when you eat at a restaurant. 
    

  • delicious food, fast service 

  • clean facilities, friendly staff 

   

 b. Building a survey using Google Forms is an optional activity.  
   

  Would you like to do this activity?  yes  no 

 

 



This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 2 Conduct a Business Survey 

 

Session 2 

Conduct a Business Survey 

In this session, students formulate a plan for their business venture. To start they 

survey their classmates to determine the type of cuisine to serve at their 

restaurant. With this data, students tabulate and chart the results using Google 

Sheets. By interpreting the survey results, students select the type of restaurant 

they would like to own and operate. They form a business plan that outlines 

the cuisine, company name, main menu items, and the target customer. 

Assignment 3: Conduct a Survey of Food Preferences 

Assignment 4: Record Survey Results in a Spreadsheet 

Assignment 5: Graph Survey Results as a Pie Chart 

Assignment 6: Develop Restaurant Idea from Survey Results 
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Assignment 4: Record Survey Results in a Spreadsheet 

You have surveyed people to find the type of food they like. 

 

Put the survey results into a spreadsheet.  

This will make it easier to study the information. 

 

Open Google Sheets and Rename a Workbook 

 Sign into Google Drive. 

 Click New. From the list, select Google Sheets.  

 In the TOP LEFT CORNER, click Untitled spreadsheet.  

Type Restaurateur. Press ENTER. 

 

Rename the Sheet Tab 

 Click the sheet tab arrow. 

Select Rename. 

 Type Survey. Press ENTER.  

 

Add a Title 

 In cell A1, type Food Survey. 

 Press ENTER. 

 

Organize Survey Results 

 In cell A3 type Food. 

 In cell B3 type Votes. 

 In cell A4 type a food name from the Assignment 3 survey. Press TAB. 

 In cell B4, record the number of votes for the food. Press ENTER. 

 Continue to add survey data. 

 A B 

1 Food Survey  

2   

3 Food Votes 

4 Pizza 8 

5 Tacos 5 

6 Chicken Wings 3 

7 Hamburgers 4 

8 Shawarma 1 

9 Pita 4 

10   
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Merge Cells for the Survey Title 

 Select A1, hold down the SHIFT key, and click E1.

 Click Merge cells.

Format the Appearance of the Title 

 With the title cell selected, make the title easy to read:

o Click Font. Pick an option.

o Click Font size. Pick a number.

o Apply a style. Click Bold  or Italic. 

Change the Text Color and Fill a Cell 

 Select the cell with the title.

 Click Fill color.

Pick a color from the palette.

 Select the text, either in the cell or from the Formula bar.

 Click Text color.

Pick a color from the palette.

Align the Title 

 Select the cell with the title.

 Click Horizontal align.

Pick Center.

Adjust Row Height and Align Vertically 

 Position the mouse pointer between row headings 1 and 2.

 Drag down.

 Click Vertical align.

Pick Middle.

Merging cells joins them 

together as one big cell. 

This makes a title look great. 

Color can be used 

to make titles and 

headings stand out. 
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Outline the Table with Borders 

 Select the survey data. 

 Click Borders.  

o Pick Border color.  

Select an option. 

o Click All borders.  

 

 

 

Resize Column Width 

 Place the mouse pointer between column headings A and B. 

 Click and drag or double click to change the size. 

 
 

 

 

Use Skills to Format the Survey Data 

 
 A B C D E 

1 Food Survey 
2      

3 Food Votes    

4 Pizza 8    

5 Tacos 5    

6 Chicken Wings 3    

7 Hamburgers 4    

8 Shawarma 1    

9 Pita 4    

10      

 

 

 
 

 

  

Make the information easy to read. 

Spreadsheet Suggestions: 
 

✓ Fill the heading cells with color.  

✓ Align the votes to the center.  

✓ Apply bold to the headings.  
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Calculate Survey Data Using SUM 

How many people did you survey?  

You need to add together, or sum, the number of votes. 

To do this quickly, you can use a spreadsheet function called SUM. 

Sum adds together the values in cells. 

The formula will look something like this: 

 

 

 

 In the cell below the last food name, type TOTAL.

 Tab to the cell beside TOTAL.

 Click Functions.   You may need to click More. 

Select SUM.

 Click the first cell with the votes. Drag down to select the list of numbers.

A B C D E 

1 Food Survey 
2 

3 Food Votes 
4 Pizza 8 

5 Tacos 5 

6 Chicken Wings 3 

7 Hamburgers 4 

8 Shawarma 1  

9 Pita 4 
10 TOTAL =SUM(B4:B9) 

 Press ENTER.

Select the cell with the formula. Look in the formula bar to see it.

 Use your skills to format Total.

Sign Out from Google Drive 

=SUM(B4:B9) 
All calculations begin with the = sign. 

This tells the spreadsheet there is a 

formula in the cell. 

SUM means the values in cells 

should be added together. 

(B4:B9) is the cell range. It tells which cells to use in the 

formula. The colon : tells the spreadsheet to include all 

cells ranging from B4 to B9. In other words B4, B5, B6, B7, 

B8, and B9. The cell range is in brackets ( ). 

The formula =SUM(…) appears in the cell. 

You need to add the cell range. 

Select the cells 

to include in 

the formula. 



 

 

This is a preview of the teacher guide. 
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Session 4
Design a Floor Plan 

In this session, students apply the drawing tools of Google Slides to design the 

floor plan of their restaurant. Students consider their clientele and the type of 

dining experience they are expecting. Shortcuts to complete the project are 

introduced as students design seating arrangements that can be easily 

grouped and duplicated to place elsewhere in the layout. Students create a 

well-designed restaurant with a focus on functionality. If time permits, an 

optional extension activity applies Slides to create an electronic bulletin board 

that displays special offers or upcoming events to customers. 

Assignment 9: Draft a Floor Plan 

Session 4 Extension Activity: Advertise a Deal 
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Assignment 9: Draft a Floor Plan 

Great news! Your investment letter worked! 

You have been given money to build and operate your restaurant. 
 

It is time to plan the layout of the restaurant. You need to ask yourself: 

• Where should you put the waiting area? 

• How should you arrange the dining tables to allow traffic flow? 

• What is the best arrangement of the kitchen appliances for staff?  

• How does the position of the restrooms or doorways change your decisions? 

• Is there space for a patio that is easily accessed through a side door? 

• Do you plan to have live bands, karaoke, or other entertainment? If so, where? 

• Are you going to have a room for business dinners, weddings, or birthday parties? 

• Will you have a takeout area for customers not dining in the restaurant? 

 

What is a Floor Plan? 
 

You will make a floor plan. A floor plan is a drawing that uses symbols and lines to show the 

location of items. Designing a floor plan is a great way to organize ideas, make purchasing 

decisions, and choose the best use of space. 
 

 
 

Be Prepared! Gather Autoshapes 
 

The floor plan will show restaurant furniture and appliances from an overhead perspective. Some 

images have been provided. However, you can also draw your own using lines and shapes. 

 

Autoshapes are available in the Restaurateur/Autoshapes folder. There are more than 20 items 

in the folder. Upload the Autoshapes folder from a local device or USB stick, or have your 

teacher post them to a shared Google Drive folder.  

 

Open Google Drawings and Name the File Floor Plan 

 Sign into Google Drive. 

 Click New. Click More. Select Google Drawings.  

 In the TOP LEFT CORNER, click Untitled drawing. Type Floor Plan. Press ENTER. 

  

View sample floor 

plan in the 

Restaurateur folder. 
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Set the Background Color of the Canvas 

 Right click on the canvas. Select Background.

Pick white from the palette.

Resize the Canvas to Suit the Restaurant Shape 

 Click File and choose Page setup.

 Choose Widescreen 16:10 from the options. Click Apply.

Make the Outside Wall 

 Click Shape.

Select Shapes and pick a shape for the restaurant.

 Click and drag to draw a shape to represent the shape of the restaurant. Make it fill the

canvas.

 Change the fill  to white, set the border color  to black, and the weight  to 3px. 

Draw the Inner Walls and Doorways 

 Press ESC or click on a blank area of the canvas to deselect the shape.

 Click Line.

Click and drag to draw a line to represent an inner wall.

 Set the line weight  to 2px. Adjust the line dash  to show doorways. 

 Use the Line  and Shape  tools to divide the restaurant into rooms. 

Hold the SHIFT 

key to draw a 

straight line. 

Where will you put the 

waiting area, dining room, 

kitchen, or restrooms? Will you 

have a patio or party room? 

TIP: Use the Line tool. 

Pick Polyline and draw 

your own shape. 
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Add Tables and Chairs to the Dining or Patio Area 

 

  Click Insert image.  

  Add a table shape from the Autoshapes folder: 

 

 
  ○ From your device, select Upload from computer . Browse to the location. Select a 

table image and click Open. 

  ○ In a shared folder, select Drive . Pick Shared with me from the navigation pane. 

Choose a folder, select a table, and click Insert. 

  ○ In your Drive, select Drive . Pick either Recent or My Drive from the Google Drive pane. 

Select a table image and click Insert. 

  Use your skills to scale  and move  the table into the correct room. 

 
 

Recolor the Table and Chairs 

 Select the table. Click Format options.  

 Open the Recolor section.   

Click the No recolor arrow  in the sidebar. Pick a choice from the options. 

 
 

Duplicate Objects to Create a Dining Area 

 Select the table. From the Edit menu, select Duplicate  or press CTRL+D. 

 Use your skills to complete the dining area.  

 
  

Ask your teacher 

where to find the 

autoshapes. 

Place a table in the 

dining area. 

Use different sized 

tables for a variety of 

seating options. 
Tip: Make the space equal between 

tables. Select several tables in a row.  

Click Arrange – Distribute – Horizontally. 
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Create a Ladies' Restroom 

 Click Insert image.

 Use your skills to add a sink or toilet from the Autoshapes folder.

 Scale  , move  , and rotate  the object. 

 Use your skills to create a restroom.

Group to Make a Gentleman's Restroom 

 Hold the SHIFT key. Click on each toilet from the ladies' room.

 From the Arrange menu select Group  or press CTRL+ALT+G. 

 Select the group. From the Edit menu, select Duplicate  or press CTRL + D. 

 OPTIONAL: To flip the group, from the Arrange menu select Rotate . Pick an option. 

 Use your skills to create another restroom.

Zoom  and click on an 

object to magnify the 

area. Click Fit to see the 

entire canvas again. 

Tip: Align objects. Select items. 

Click Arrange. Pick Align and 

select an option from the list. 

If you cannot select an object, it is likely that another 

object is in front of it. Select the top object and press 

CTRL+↓ to move it down a layer. 

To ungroup objects, right click on 

the group. Select Ungroup. 

Tip: You can edit an image, line, or 

shape within a group. Double click 

on it and make the changes. When 

you click away the objects will 

remain grouped. 
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Design the Kitchen 

 Use your skills to create a kitchen.  

 
 

Complete the Restaurant Floor Plan 

 Use the skills to complete the restaurant floor plan. For example:  

 
 

 
 

Label the Floor Plan 

 Click Text box.  

Click and drag to draw a text box. 

 Type the Room Name. 

 Use your skills to scale  and move  the text box. 

 Format the font , size , and style.  

 Label each area of the drawing.  

 

Sign Out of Google Drive 

Tips for Designing a Floor Plan: 

 

✓ Insert images  from the Internet using the Search feature. 

✓ Be creative! Add an aquarium, booth seating, plants, or coat closet. 

✓ When using Zoom  press CTRL+ALT++ to zoom out and CTRL+ALT+- to zoom in. 

✓ Use the red guidelines to align objects in Google Drawings. 

Tip: You can nudge an object to 

move it easily. Press the SHIFT key and 

an arrow key. 

Where will you put the 

stoves, ovens, sinks, 

dishwasher, food prep 

area, storage, and freezers? 

You may want to 

label items. 



This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 6 Promote a Business Opportunity 

 

Session 6 

Promote a Business 
Opportunity 

In this session, students create a newsletter for aspiring restaurateurs interested 

in joining a restaurant chain. The publication's aim is to persuade them to 

become part of the team and open their own restaurant. It will include the 

same company logo, offer identical menu items, and showcase a similar floor 

plan. Additionally, the newsletter will highlight potential earnings and outline 

the benefits of participating in the business venture. Can you convince others 

to join the team? 

Assignment 13: Design a Business Opportunity Newsletter 

 

Session 6 Extension Activity 1: Share Files with Investors 

Session 6 Extension Activity 2: Rate Opinions in Forms 
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Assignment 13: Design a Business Opportunity Newsletter 

Your restaurant is a success! 

It is time to open a chain of restaurants. Each new restaurant 

will use the same company logo, serve the identical menu 

items, and have a similar floor plan.  

You need to find people interested in running their own 

restaurant. Each year they will pay money to copy your restaurant idea. This is called franchising. 

A franchise will allow you to expand your business by licensing your restaurant idea to others. 

Design a newsletter to convince others that your restaurant idea is a great business opportunity. 

Open Google Docs and Rename a Document 

 Sign into Google Drive.

 Click New. From the list, select Google Docs.

 In the TOP LEFT CORNER, click Untitled document.

Type Newsletter. Press ENTER.

Change the Page Color 

 From the File menu, select Page setup.

Click Page color and pick an option. Click OK.

Special Character: Create a unique 

design with special characters. 

Logo: Add the company logo 

created in Assignment 7. Join the Team: Explain the reason 

the restaurant is a good investment. 

Discover the Benefits: Use custom 

bullets to make a list. 

Earn Money: Use a table to list the 

yearly and average quarterly earnings. 

Footer: Add the company address. 

Click Custom to 

pick an option from 

the color spectrum. 

Click OK. 

Header: Add the company website. 

Horizontal Rule: Divide the newsletter 

into sections. 

Line Graph: Add the graph created 

in Assignment 13. 

Floor Plan: Add the floor plan 

created in Assignment 9. 

Newsletter Title: Attract investors to 

open a restaurant franchise. 

View a sample 

newsletter in the 

Restaurateur folder. 
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Add Newsletter Title 

 Type your Restaurant Name. Press ENTER. 

Type Business Opportunity. Press ENTER twice. 

 Use your skills to change the font , size , style , color , or alignment.  

 
 

Explain Reasons to Join the Team 

 Below the title, type the heading Join the Team. Press ENTER twice. 

 Use your skills to change the font , size , style , color , or alignment.  

 Write an introductory paragraph to convince someone your restaurant is a good idea. 

o Why is your restaurant a good business opportunity? 

o What makes your restaurant idea unique? 

o What is the benefit to joining your team? 

 Press ENTER twice. 

 
 

List Benefits Using Bullets 

 Below the paragraph, type the heading Discover the Benefits. Press ENTER twice. 

Format the text. 

 Click to place the cursor just below the heading. 

Type three things customers like about the restaurant. Press ENTER after each item. 

 Press ENTER twice. 

 Select the list. 

 Click the Bulleted list  arrow and choose from the options. 

 
  

Use a different font for Business Opportunity. Click Font . Click 

More fonts . Pick an option from the list, then click OK. 

Pizza Pete 
Business Opportunity 

 

Join the Team 
 

Are you looking for a great business opportunity? Pizza Pete is a restaurant that offers 

healthy food at an affordable price. We use organic ingredients to make our famous 

pizza and panzerotti. When you join our team, you benefit from our expertise plus you 

get the recipe for our secret sauce! 

Be personal but 

professional! Use 

the word “you” to 

connect with the 

reader.  



Session 6 

Copyright © TechnoKids Inc. 52 TechnoRestaurateur | Google Workspace 

Emphasize List with Custom Bullets 

 Click the cursor in the first list item.

 From the Format menu, select Bullets & numbering.

Click List options. Click More bullets.

o Narrow the results by choosing subcategories from the menus.

o Search by keyword.

o Click and drag to draw a symbol. Matching options will be displayed.

 Click on a symbol to add it as a bullet.

 Click Close. X

Add a Table 

You will insert a table to divide the newsletter into parts. By filling the table with color, you can 

make information stand out on the page. 

 Below the list, type the heading Earn Money.

 Press ENTER twice.

Format the text.

 Click to place the cursor just below the heading.

 Insert a table:

o From the Insert menu, select Table.

o Select 1 x 1.

Pick Symbol. 

Pick Emoji. 

Pick a subcategory or type 

a search word into the box. 

To remove an 

unwanted bullet, click 

Bulleted list. 
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Outline Restaurant Earnings in the Table 

 Inside the table cell, inform investors about what they can expect to earn in their first 

year of business. List the yearly earnings and average quarterly earnings. 

 Use your skills to format the table cells: 

o Place the cursor inside the table cell. 

o Fill the background color.  (You may need to click More  on the toolbar.) 

o Set the border color , border weight , and border dash.  

 
 

Insert a Header and Footer with Contact Details 

 Insert company website information into the header: 

o Double click at top of the page  

or click the Insert menu and choose Headers & footers . Pick Header. 

o Type the company website address. 

o Change the alignment to left , center , or right.  

 Click on the newsletter to close the header. 

 Insert company address into the footer: 

o Double click at the bottom of the page  

or from the Insert menu choose Headers & footers . Pick Footer. 

o Type the company address. 

o Change the alignment to left , center , or right.  

 Click on the newsletter to close the footer. 

 

Divide the Newsletter into Sections Using a Horizontal Line 

 Place the cursor below the title or a heading. 

 From the Insert menu, select Horizontal line.  

 Continue to add horizontal lines to divide content. 

 

  

 

Earn Money 

Why wait to make money? 
Start making money right now! 

 

$100, 000 yearly earnings. 

$26, 000 quarterly earnings. 

Drag the 

borderline to 

change the size. 

The yearly and 

quarterly earnings are 

on the Earnings sheet 

in the Restaurateur 

workbook. 
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Insert Company Logo, Floor Plan, and Line Chart 

 Position the cursor where you would like to place the company logo.

You can set the wrapping or alignment afterwards.

 From the Insert menu, select Drawing.

Choose From Drive  to select the logo created in Assignment 7. 

 Click Insert. Pick Insert unlinked. Click Insert.

 Select the logo. Drag  a corner handle to make the logo smaller. 

 Click Wrap text.

 Drag  the logo to place it on the page. 

 Use your skills to insert the Floor Plan (Created in Assignment 9)

and Quarterly Earnings chart (Created in Assignment 13).

Add Custom Symbols to Create a Unique Design 

 Position the cursor beside a heading.

 From the Insert menu, select Special characters.

 Click on a symbol to create a unique design. Click Close.

Complete the Newsletter, then Sign Out of Google Drive 

Change the margin to 0" 

margin to place the logo 

closer to text. 

Pick Behind text  if you do 

not want the words to move. 

1. Choose Categories.

2. Pick a style.

3. Pick a subcategory.

4. Search by drawing a

symbol or keyword.

Pick a style 

Newsletter Tips: 

✓Make the newsletter

fit on one page.

✓ Add white space to

chunk information.

✓ Ask questions and

then answer them.

✓ Be creative! Add

testimonials or a

motto.

✓ Draw attention to

the trend line.

✓ Appeal to the

reader’s emotion.

✓ Add links to floor

plan or worksheet in

Extension Activity 3.

✓ Right click on a table

cell and add a row

above or below, or a

column to the right

or left.

Subcategory 
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Newsletter Checklist  

Newsletter Content ✓ 

title is well formatted and stands out on the page  

headings organize information into logical sections  

reasons explain why the restaurant is a good business opportunity  

financial information is organized in a simple table  

unique restaurant features are highlighted using a bulleted list  

header includes company website and footer includes company address  

Newsletter Design ✓ 

content is divided into sections using a horizontal rule  

special characters are used to produce a creative design  

bulleted list uses unique symbols that are appropriate  

graphic elements are well formatted and arranged attractively on the page  

white space is used to chunk information and create an uncluttered design  

newsletter fits on one page  

Floor Plan ✓ 

includes all necessary parts of a restaurant  

organized to meet the needs of patrons and staff  

uses suitable symbols to represent objects  

labels clearly identify each area  

design is creative  

Line Chart ✓ 

displays quarterly earnings  

labels clearly identify information  

shows the direction of earnings using a linear trend line  

formatted attractively  

Writing Style ✓ 

newsletter connects with the reader using a second person writing style  

information is logically organized and chunked into sections  

tone is appropriate for a newsletter  

newsletter is persuasive  

grammar and spelling are correct  
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Session 6 Extension Activity 2: Rate Opinions in Forms 

Google Forms lets you build a survey and have people complete it electronically. 

The data is automatically graphed. 

Customer satisfaction is important. Happy customers are likely to return to the restaurant. 

Design a survey that uses a grid with a scale that allows people to rate their opinion. 

A grid can be used to list many items. It is a great way to assess opinions because the choice is 

the same for every item. A scale range can be low to high, strongly disagree to strongly agree, 

unimportant to important, poor to excellent, never to always, or yes or no.  

Pick a survey question or come up with your own idea: 

• Did you like the service? Rate each statement as great job, okay, or needs work.

• What entertainment should we add? Which ideas do you love, like, or dislike?

• What new menu items would you order? Check yes or no to tell us which ones to add.

1. Sign into Google Drive. Click New. Select Google Forms.

2. Type a survey title such as Restaurant Survey.

Type in a description such as Tell us what you think!

3. Click Untitled Form at the top to automatically name the file.

4. Ask a question:

a. In the Question box type a question.

b. Select Multiple choice grid as the question type.

c. Add the row labels. Type items you want people to rate.

d. Add the column labels. Type rating scale choices.

e. Select Require a response in each row.

The choices can be yes/no, 

disagree/undecided/agree, 

or dislike/like/love. 

The items can be written as 

questions or statements. 



  Session 6 

Copyright © TechnoKids Inc. 59 TechnoRestaurateur | Google Workspace 

5. Click Customize Theme.   

 a. Choose image  to select a picture. 

 b. Click Insert. 

 
 

6. Click Settings. Under Responses, turn Limit to 1 response ON. 
 

   
 

 

8. Click Questions. Read the survey. Are there any spelling mistakes? Fix any mistakes. 

 

9. Ask your friends to pretend to be customers and fill out your survey.  

 a. Click the Send button. 

 b. In the To box type email addresses.  

  In the Subject box type the Survey Name, if necessary. 

 c. Click Send. 

 
 

  

Pick a picture theme.  

You can include the form 

in the email message. 

Email about 10 people. 

You may want to 

add a thank you 

message under 

Presentation. 

Allow each person 

to take the survey 

only once. 
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10. Wait for people to take your survey.

To see their responses, view the form. Click the Responses tab.

Analyze Survey Results 

1. What were the results of your survey?

2. Compare survey methods.

Do you prefer to gather data using Google Forms or a tally sheet? Why?

The survey results are 

displayed in a graph. 



 

 

 

Appendices 

 

Appendices 

 

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

Appendix B: Contact Information 

 



This is a preview of the teacher guide. 

Pages have been omitted. 
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Appendix A: Assessment Tools 

Professional Letter Marking Sheet 

Parts of a Professional Letter  

• letterhead includes company name and address. 

• letter includes the date of writing. 

• inside address includes recipient name and address. 

• salutation offers a professional greeting to the recipient. 

• body describes the business plan, offers reasons the restaurant will be 

successful, and instructs the reader what to do after reading the letter. 

• closing offers a professional farewell to the recipient. 

• signature line includes restaurant name, student name, job title, and space for 

a signature. 

• letter is formatted appropriately. 
/10 

Company Logo  

• simple shapes and word art are used to create a unique logo. 

• logo represents restaurant concept. 

• design is creative. 
/5 

Pie Chart  

• pie chart displays survey results. 

• chart includes labels that clearly identify information. 

• chart is well-formatted. 
/5 

Business Plan  

• business name is original. 

• plan is logical and is based on survey results. 

• plan is clearly explained and offers details such as target customer or menu. 
/5 

Writing Style  

• point of writing is clearly outlined early in the letter. 

• information is logically organized and chunked into paragraphs. 

• tone is appropriate for a professional letter. 

• letter is persuasive and convinces the reader to invest. 

• grammar and spelling are correct. 
/5 

TOTAL: /30 
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Newsletter Marking Sheet 

Newsletter Content 

• title is well formatted and stands out on the page.

• headings organize information into logical sections.

• reasons explain why the restaurant is a good business opportunity.

• financial information is organized in a simple table.

• unique restaurant features are highlighted using a bulleted list.

• header includes company website and footer includes company address.
/10 

Newsletter Design 

• content is divided into sections using a horizontal rule.

• special characters are used to produce a creative design.

• bulleted list uses unique symbols that are appropriate.

• graphic elements are well formatted and arranged attractively on the page.

• white space is used to chunk information and create an uncluttered design.

• newsletter fits on one page.
/10 

Floor Plan 

• includes all necessary parts of a restaurant.

• organized to meet the needs of patrons and staff.

• uses suitable symbols to represent objects.

• labels clearly identify each area.

• design is creative.
/5 

Line Chart 

• displays quarterly earnings.

• labels clearly identify information.

• shows the direction of earnings using a linear trend line.

• formatted attractively.
/5 

Writing Style 

• newsletter connects with the reader using a second person writing style.

• information is logically organized and chunked into sections.

• tone is appropriate for a newsletter.

• newsletter is persuasive.

• grammar and spelling are correct.
/5 

TOTAL: /35 



This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 



Pizza Pete
123 Pepperoni Lane 

Pizzaville, CA, 90210 

555-749-9292

October 30, 2020 

TechnoBank 

1000 Money Ave. 

Pizzaville, CA, 90210 

Dear Mrs. Teacher: 

I am writing to request investment capital for an exciting new restaurant venture. I plan to open 

a Pizza Parlor called Pizza Pete. Research results have shown that people in the community 

prefer pizza to other foods such as tacos, chicken wings, hamburgers, shawarma, and pita. 

The restaurant will be successful because it will offer healthy fast food choices. The pizza and 

panzerotti will be made with homemade sauce and organic ingredients. We plan to cater to 

families that are too busy to cook but want healthy food that their children will eat. 

I ask you to contact me at 555-749-9292 to discuss this investment opportunity. I look forward to 

hearing from you. 

Sincerely, 

Pizza Pete 

Student Name 

President 
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